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Introduction   The Octopus USB Controller (OUC) is designed to allow interfacing of a variety USB 
control devices with a Windows-based computer.  This application has many unique features including: 
 

¶ Compatibility with most commonly used USB Human Interface Devices (HID) with user 
selectable buttons or pedals, including those listed below (see full list of compatible devices at 
the end of this guide): 

o all SpeechWare devices (TableMikes, hand-held keyboard, and single and triple USB 
foot pedals) 

o a variety of hand-held USB microphones, including those made by Dictaphone/Nuance, 
Grundig, Olympus and Philips 

o most commonly available USB foot pedals 
o all commonly marketed USB keypads 

¶ Ability to simultaneously support multiple USB devices (multi-device awareness) 

¶ SǳǇǇƻǊǘ ŦƻǊ άƘƻǘ ǎǿŀǇǇƛƴƎέΤ ƛΦŜΦ ŎƻƴƴŜŎǘƛƻƴ ƻǊ ŜȄŎƘŀƴƎŜ ƻŦ ǇŜǊƛǇƘŜǊŀƭǎ ƻƴ ǘƘŜ Ŧƭȅ ǿƛǘƘƻǳǘ 
restarting the application 

¶ Extremely intuitive user interface facilitating ease of use 

¶ Exporting and importing of device profile to facilitate sharing of device settings 

¶ Advantage of having a single interface with multiple devices to facilitate ease of use across large 
organizations 
 

Using this control application, you can initiate a variety of actions with applications on virtually all 
recent vintage Windows operating system, including: 
 

¶ Inserting blocks of predefined άōƻƛƭŜǊǇƭŀǘŜέ text  

¶ Pressing a keyboard key or key combination with your hand-held USB microphones and/or USB 
foot pedals 

¶ Emulating a variety of native Dragon NaturallySpeaking commands 

¶ Emulating any user-defined Dragon NaturallySpeaking command 

¶ Initiating a variety of Dragon hot-keys 

¶ Opening any application, document, folder or web page 

¶ Initiating a number of operating system functions such as opening Task Manager, moving 
through applications on the desktop, clearing the desktop and more. 

¶ Programming separate functions to the pressing and releasing of a key, button or lever 

¶ Executing sequential repetitive custom scripts involving consecutive steps involving any of the 
above functions 

Compatibility  
 
Operating Systems:  Octopus Control Utility is compatible with most common Windows operating 
systems, including Windows XP, Vista,7, & 8. 
 
USB Devices Compatibility:  ! ƭƛǎǘ ƻŦ ŎǳǊǊŜƴǘƭȅ ŎƻƳǇŀǘƛōƭŜ ŘŜǾƛŎŜǎ ǎƘƻǿǎ ǳǇ ƛƴ ǘƘŜ ά!ŎǘƛǾŜ ¦{. IL5 
5ŜǾƛŎŜ ΦΦέ ŘǊƻǇ-down in the main OUC window.  Also see a list of currently compatible devices in the 
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appendix of this User Gide.  Realize, however, that this list is constantly growing.  For an updated list of 
currently compatible devices, also visit http://www.tablemike.com/en/download-applications.php or 
http://www.USBController.com  
 
Keypad Compatibility:  to date, all commonly marketed USB keypads have been found to be compatible 
with OUC.  
 

Installation/Licensing/Activation  
 

Installation:  Octopus Control Utility is installed by download from the Internet.  Installation is 
straightforward and involves the following steps:  
¶ Unzip the downloaded file by right-ŎƭƛŎƪƛƴƎ ƻƴ ƛǘ ŀƴŘ ǎŜƭŜŎǘƛƴƎ ά9ȄǘǊŀŎǘ CƛƭŜǎέ 

¶ /ƭƛŎƪ ƻƴ ǘƘŜ ƛŎƻƴ ƭŀōŜƭŜŘ ά{ŜǘǳǇέ   

¶ Follow all subsequent instructions (installation takes less than 1 minute) 
 

Activation: 
¶ OCU can be used on a trial basis for 3 instances before formal licensing and activation is 

required. 

¶ Entering an activation code:  if you purchased your copy of OUC it should have been 
accompanied by an activation code.  This code can be entered as follows: Navigate to Help > 
License activation ΧΦ  hƴ ǘƘŜ ǿƛƴŘƻǿ ǘƘŀǘ ǎƘƻǿǎ ǳǇΣ ŜƴǘŜǊ ȅƻǳǊ ŀŎǘƛǾŀǘƛƻƴ ŀƴŘ ƻǘƘŜǊ ǊŜǉǳŜǎǘŜŘ 
information.   

¶ If you downloaded a trial version of OUC, you will need to purchase an activation code to use 
the product after the initial 3 free uses have ended. If you obtained the download from the 
Octopus USB Controller website, you can find a list of current OUC resellers on this site 
(www.OctopusUSBController.com) If your trial download came from a certified reseller, you will 
see a link to your reseller on both the activation screen and on the product splash screen. Once 
you purchase an activation code, enter it using the method described above. 
 

Upgrading:  During the period during which you are eligible for free upgrades, when upgrades become 
available you will be automatically notified of this upon opening OUC and will be given the option of 
downloading the update immediately.  Alternatively, you can check for the availability of updates by 
navigating to Help > Update.  Either way, you will be walked through the updating process.  If an update 
cannot be accomplished this may be a result of not having administrative privileges on your computer.  
In such cases, we recommend that you follow this procedure: 
 

¶ /ƭƛŎƪ ǘƘŜ άŎŀƴŎŜƭέ ōǳǘǘƻƴ ǘƻ ŜƴŘ ǘƘŜ ǳǇŘŀǘŜ ǇǊƻŎŜǎǎ 

¶ Close OUC 

¶ Find OUC from the Windows Start menu (All Programs > SpeechWare > Octopus USB Controller 

¶ wƛƎƘǘ ŎƭƛŎƪ ƻƴ hŎǘƻǇǳǎ ¦{. /ƻƴǘǊƻƭƭŜǊ ŀƴŘ ǎŜƭŜŎǘ άtǊƻǇŜǊǘƛŜǎέ ŀƴŘ Ǝƻ ǘƻ ǘƘŜ ά/ƻƳǇŀǘƛōƛƭƛǘȅέ ǘŀōΦ 

¶ /ƘŜŎƪ ǘƘŜ ōƻȄ άwǳƴ ǘƘƛǎ ǇǊƻƎǊŀƳ ŀǎ ŀƴ ŀŘƳƛƴƛǎǘǊŀǘƻǊέ ŀƴŘ ŎƭƛŎƪ ǘƘŜ ά!ǇǇƭȅέ ōǳǘǘƻƴ 

¶ Re-launch OUC and re-start the update procedure 
 

Licensing:  Standard OUC licensing allows use on two computers without limit.  Use is accompanied by 
free upgrades and support for a period of 1 year.  After this one-year period it shall be necessary to 

http://www.tablemike.com/en/download-applications.php
http://www.usbcontroller.com/
http://www.octopususbcontroller.com/
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purchase a new activation code in order to allow continued product upgrades and support.  To view the 
End User Licensing Agreement (EULA) please visit www.OctopusUSBController.com . 
 

Support: Support of OUC is provided on a complimentary basis for one-year following your purchase.  
Initial support is provided by the reseller from which you purchased your activation code.  SpeechWare 
is very interested in knowing if you identify an incompatibility or bug and such issues can be reported 
directly to SpeechWare by means of the functionality reached at Tools > Report incompatibility or 
ǇǊƻōƭŜƳ Χ 

General Instructions for Use:  

General Set-up and Usage: 
 

¶ Complete installation as detailed above 

¶ Plug in your compatible USB device either before or after starting the utility.  Actual 
programming for your specific device cannot take place until after the USB device is attached 
and recognized by Windows and OUC. 

¶ Launch OCU from the Windows Start Menu or from a desktop icon; by default it will appear only 
in the tool bar ς show the full application control window by right clicking on the toolbar icon 
and selecting View > Floating Window 

¶ Device Detection:   
 

USB microphones, foot pedals, TableMikes: Assuming you have a compatible device 
connected, it will be automatically detected and will show up as an active device on the 
ά!ŎǘƛǾŜ ¦{. IL5 5ŜǾƛŎŜ ǘƻ ŎƻƴŦƛƎǳǊŜέ ŘǊƻǇŘƻǿƴ ƻƴ ǘƘŜ Ƴŀƛƴ h¦/ ǎŎǊŜŜƴΦ  Connected active 
devices will be shown in the upper area of the drop-down and in bold font, while the list of 
non-detected devices is grayed-out and listed below. 

 

 
 

If you select your device from the drop-down menu, you will see a visual representation of 
your device (see image below which demonstrates appearance of connected 
Nuance/Dictaphone PowerMic II).  If you have multiple devices attached, they will all be 
sensed by OUC and will work, although you will ƴŜŜŘ ǘƻ ǎŜƭŜŎǘ ȅƻǳǊ ŘŜǾƛŎŜ ŦǊƻƳ ǘƘŜ ά{ŜƭŜŎǘ 
5ŜǾƛŎŜέ ŘǊƻǇ-down menu in order to program behavior for that device.  Until you program 
your own behavior for each button or pedal on each device it will follow the default 
behavior chosen by SpeechWare.  

http://www.octopususbcontroller.com/


 

5 
 

 

 
 

Keypads:   YŜȅǇŀŘǎ ŀǊŜ ǎŜŜƴ ŀƴŘ ǇǊƻƎǊŀƳƳŜŘ ōȅ ǎŜƭŜŎǘƛƴƎ ά!ŎǘƛǾŜ YŜȅōƻŀǊŘ ϧ External 
YŜȅǇŀŘǎέ ŦǊƻƳ ǘƘŜ Active USB HID Device menu.  Until you actually program a key (described in 
detail below) you will not see a representation of the individual keys on the device. 
 
Non-recognized devices:  If your device is not one which is pre-programmed by SpeechWare 

it will not show up on the drop-Řƻǿƴ ƳŜƴǳ ŀƴŘ ǿƛƭƭ ƴŜŜŘ ǘƻ ōŜ άƭŜŀǊƴŜŘέ ōȅ h¦/ ǳǎƛƴƎ ǘƘŜ 
ά!ǳǘƻ[ŜŀǊƴέ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ŘŜǎŎǊƛōŜŘ ōŜƭƻǿΦ 
 

Launching Dragon NaturallySpeaking:   If you are planning to use OCU with Dragon, you can 
launch it at any time, using the normal method for launching Dragon from the Start Menu, desktop 
shortcut, etc.  If 5ǊŀƎƻƴ ƛǎƴΩǘ ƭŀǳƴŎƘŜŘ ǿƘŜƴ ȅƻǳ ƭŀǳƴŎƘ h¦/ ǘƘŜ ƻƴƭȅ ŎƻƴǎŜǉǳŜƴŎŜ ƛǎ ǘƘŀǘ ŀƴȅ ōǳǘǘƻƴǎ 
on your device programmed for Dragon-related functions will be grayed out and will not work until you 
launch Dragon.   
 

Programming a key on your USB Microphone, SpeechMike or Foot Pedal (see separate 
instructions for programming a USB keypad) :  Once your USB device is selected from the 
Active USB HID Device drop-down menu you will see that each button on your connected device is 
assigned a name on the left-hand column of the main OCU application window.  Directly to the right of 
the name column is the list of currently assigned actions for each button.  If you are uncertain of where 
a specific button on your device shows up on the list, simply push the button on your hand-held device 
or foot pedal and the associated line will be highlighted.  
                 
Follow these basic steps to program a button (more detailed information on each programming function 
is shown later in the User Guide): 

 

¶ Double click on the line associated with the button you wish to program.  This will open the 
ά¦{. 5ŜǾƛŎŜ {ŜǘǘƛƴƎǎέ ǿƛƴŘƻǿ ǎƘƻǿƴ ōŜƭƻǿΦ 
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¶ You will see there are 8 categories of button assignment: 

 
o Boilerplate Text: add text into the area and then with a single press of a button or pedal 

it will be inserted at the cursor location in any word processing application or text 
window. 

o Dragon Commands:  this is the area where you can assign a number of pre-configured or 
user-defined dragon commands to a button push.   

o Dragon hotkeys:  this is a series of functions which can typically be assigned from the 
Dragon Options > hotkeys menu and include programming a button to turn the 
microphone on/off, open the dictation box, etc. 

o Keyboard Emulation:  this area allows you to program a key depression on your USB 
device to emulate a single key or key combination.  It includes the modifiers alt, shift 
and ctrl 

o Launch:  this allows you to assign opening of a program, document, folder or web-page 
to a button push/pedal push. 

o Windows:  Use this tab to access programming of a series of Windows related activities, 
including resizing windows, opening the Task Manger, opening the Control Panel, etc. 

o Custom Script: this is a series of actions that you can execute sequentially. Add or 
remove from the list as you wish. 

o Advanced:  this tab allows assignment of separate functions to the depression and 
release of a button, lever or key. 

 

¶ Select the tab/category based on your preference 

¶ Select the specific function your desire to assign to a button 

¶ Click OK 
 

Programming a key on your On-Board Keyboard or USB KeyPad:  This process is slightly 
different from programming other USB devices.   
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¶ If using an external keypad, it should be connected and you must wait until all drivers are 
installed by the operating system (not necessary if programming a key on the on-board 
keyboard) 

¶ If not already selected, from the Active ¦{. IL5 5ŜǾƛŎŜ ŘǊƻǇ Řƻǿƴ ƻƴ h¦/ ǎŜƭŜŎǘ ά!ŎǘƛǾŜ 
YŜȅōƻŀǊŘ ϧ 9ȄǘŜǊƴŀƭ YŜȅǇŀŘǎέΦ  ¸ƻǳ ǿƛƭƭ ǎŜŜ ŀ ǊŜǇǊŜǎŜƴǘŀǘƛƻƴ ƻŦ ŀ ƪŜȅǇŀŘΣ ŀǎ ǎƘƻǿƴ ōŜƭƻǿΦ  
Before any programming is initiated you will not see any keys or actions listed. 

¶ Program a key as follows, using the image below as both a guide and example of how 
programming will appear: 

¶ /ƭƛŎƪ άŀŘŘέ ǘƻ ƛƴƛǘƛŀǘŜ ǇǊƻƎǊŀƳƳƛƴƎΦ  ¸ƻǳ ǿƛƭƭ ǎŜŜ ǘƘŜ ŘƛŀƭƻƎ ōƻȄ ǎƘƻǿƴ ōŜƭƻǿ ǘƻ ƛƴŘƛŎŀǘŜ ǘƘŜ 
next step. 
 

 
 

¶ Depress the key on your on-board keyboard or external keypad you wish to program.  As soon 
ŀǎ ȅƻǳ ŘƻΣ ǘƘŜ Ŧǳƭƭ ά¦{. 5ŜǾƛŎŜ {ŜǘǘƛƴƎέ ǿƛƴŘƻǿ ǿƛƭƭ ŀǇǇŜŀǊΣ ŦǊƻƳ ǿƘƛŎƘ ȅƻǳ Ŏŀƴ ŎƘƻƻǎŜ ǘƘŜ 
desired programming, just as with other external USB devices described above.  Once keys are 
programmed, your device may look as shown below. 
 

 
 

¶ Previously created behavior for a key on a keypad can be modified by double-clicking on the line 
ŀǎǎƻŎƛŀǘŜŘ ǿƛǘƘ ǘƘŜ ōǳǘǘƻƴ ƻǊ ƘƛƎƘƭƛƎƘǘƛƴƎ ǘƘŜ ƭƛƴŜ ŀƴŘ ŎƭƛŎƪƛƴƎ ά9Řƛǘέ 
 

Programming a Device Not Recognized by OUC 
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If you are attempting to use a USB device which is not recognized by Octopus USB Controller, it is 
necessary to manually add the device.  This works as follows: 
 

¶ Attach the device to an available USB port and be sure all drivers are installed 

¶ NavigŀǘŜ ǘƻ ¢ƻƻƭǎ Ҕ hǇǘƛƻƴǎ ŀƴŘ ǎŜƭŜŎǘ ǘƘŜ ά!ǳǘƻ[ŜŀǊƴέ ǘŀō 
 

 
 

¶ /ƭƛŎƪ ƻƴ ǘƘŜ ά{ǘŀǊǘ /ƻƴŦƛƎǳǊŀǘƛƻƴέ ōǳǘǘƻƴ 

¶ Sequentially press on each button or lever on your attached device, looking to see that the small 
red indicator briefly flashes green with each press to indicate that the event was recognized 

¶ !ŦǘŜǊ ŜŀŎƘ ƻŦ ǘƘŜ ōǳǘǘƻƴǎ ƘŀǾŜ ōŜŜƴ ǇǳǎƘŜŘΣ ŎƭƛŎƪ ƻƴ ǘƘŜ άŦƛƴƛǎƘ ŎƻƴŦƛƎǳǊŀǘƛƻƴέ ōǳǘǘƻƴΦ 

 

Details on Assigning Functions to Buttons : 
 
Boilerplate Text:  Assigning a button or lever on a USB device to insert boilerplate text is a useful 
function if there are certain chunks of text (single words, phrases, or longer passages) that you use 
regularly and may want to insert into a word processing document or text entry window on a regular 
basis.  Examples include a signature line, an email address, or perhaps a password.   

 
Setting up boilerplate text entry is as easy as choosing the Boilerplate text tab and by any means you 
choose entering this text into the main window ς see below: 
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Note:  At this time it is not possible to add formatting to text used in the boilerplate command.  This is a 
functionality expected during a future upgrade. 

 
 
Dragon Commands:  This series of choices allows you to program your USB device to activate 
specific commands for users of Dragon NaturallySpeaking, including both intrinsic (built in) commands 
and personalized commands you have created.  It comes with a series of common commands which can 
be directly chosen.  Alternatively you can select the top ŎƘƻƛŎŜ όά¢ȅǇŜ ōŜƭƻǿ ǘƘŜ ŜȄŀŎǘ ƴŀƳŜ ƻŦ ǘƘŜ 
DraƎƻƴ ±ƻƛŎŜ /ƻƳƳŀƴŘ Χύ and enter the exact command name below, and this will initiate the 
command as if it was enunciated aloud. 
 

 
 
Note:  When assigning a άǳǎŜǊ ŘŜŦƛƴŜŘέ ŎƻƳƳŀƴŘ, it is important that you enter the word or words with 
the proper case (capitalization).  If in doubt about what Dragon is expecting, issue the command by 
ǾƻƛŎŜ ŀƴŘ ǘƘŜƴ Ǝƻ ǘƻ ǘƘŜ ²ƻǊŘǎ ƳŜƴǳ ŀƴŘ ǎŜƭŜŎǘ ά±ƛŜǿ wŜŎƻƎƴƛǘƛƻƴ IƛǎǘƻǊȅ Χέ ǘƻ ǎŜŜ ŜȄŀŎǘƭȅ Ƙƻǿ ǘƘŜ 
word or words are formatted.  Copy this when entering the command name into OUC.  
 
bƻǘƛŎŜ ǘƘŀǘ Ƴŀƴȅ ƻŦ ǘƘŜ 5ǊŀƎƻƴ ŎƻƳƳŀƴŘǎ ŀǊŜ ŦƻǊ ǎǇŜŎƛŦƛŎ ŜǾŜƴǘǎ ǘƘŀǘ ȅƻǳ ǇǊƻōŀōƭȅ ǿƻƴΩǘ ǿŀƴǘ ǘƻ 
ŎƻƴǘƛƴǳŜ ƛƴŘŜŦƛƴƛǘŜƭȅΣ ǎǳŎƘ ŀǎ άŀƭƭ ŎŀǇǎ ƻƴέΣ άƴǳƳōŜǊ ƳƻŘŜ ƻƴέΣ ŜǘŎΦ  CƻǊ ǘƘŜǎŜ ǘȅǇŜǎ ƻŦ ŎƻƳƳŀƴŘǎ ȅƻǳ 
may want assign separate functions to a key depression and release, for example assign the depression 
ǘƻ άƴǳƳōŜǊǎ ƳƻŘŜ ƻƴέ ŀƴŘ ǘƘŜ ǊŜƭŜŀǎŜ ǘƻ άƴǳƳōŜǊǎ ƳƻŘŜ ƻŦŦέΦ  Lƴ ǘƘƛǎ ǿŀȅΣ ȅƻǳ Ŏŀƴ ƘŀǾŜ ŘǊŀƎƻƴ ŜƴǘŜǊ 
a specific mode only during the depression of a key, button or lever and that action or mode will end 
with the release of key. 
 

Dragon HotKeys:  These are a series of Dragon functions which can traditionally be assigned to a 
ƪŜȅōƻŀǊŘ ƪŜȅ ŦǊƻƳ 5ǊŀƎƻƴΩǎ hǇǘƛƻƴǎ Ҕ IƻǘYŜȅǎ ƳŜƴǳΦ  LƴŎƭǳŘŜŘ ǿƛǘƘƛƴ ǘƘƛǎ ŎŀǘŜƎƻǊȅ ŀǊŜ ŀƭƭ ǘƘŜ 
functionalities provided in the Dragon Hotkeys menu, including: 
 

¶ Microphone on/off 

¶ Fast forward 

¶ Force command recognition 
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¶ Force dictation recognition 

¶ DragonBar menu 

¶ Microphone sleep/on 

¶ Press-to-talk 

¶ Dictation Box 

¶ Playback 

¶ Next field 
 

Keyboard Emulation :  This is a very helpful functionality useful if the application you are using (an 
electronic medical record, for instance) allows for certain functions to be initiated with a keystroke or 
key combination.  Follow this procedure to assign a key combination to your USB device: 

 
 

 
 

¶ Select the Keyboard Emulation tab 

¶ /ƭƛŎƪ ƻƴ ǘƘŜ ά/ƘŀƴƎŜ ƪŜȅǎ Χέ ōǳǘǘƻƴΦ  ¢Ƙƛǎ ǿƛƭƭ ŎŀǳǎŜ ǘƘŜ /ƘŀƴƎŜ YŜȅǎ ƻǇǘƛƻƴǎ ōƻȄ ǘƻ ƻǇŜƴΦ 

¶ Type the key or key combination using your actual keyboard and it will show-up in the text box 
in the Change Keys options box 

¶ If the key or key combination is not available on your actual keyboards, you can click on the 
small virtual keyboard shown above and it will open a much larger virtual keyboard from which 
you can choose addition keys and key combinations. 
 

 
 

¶ !ǎ ƴŜŜŘŜŘΣ ŎƭƛŎƪ ǘƘŜ ōƻȄŜǎ ƴŜȄǘ ǘƻ ά/ƻƴǘǊƻƭέΣ ά{ƘƛŦǘέΣ ŀƴŘ ά!ƭǘέ ŦƻǊ ƪŜȅ ŎƻƳōƛƴŀǘƛƻƴǎΦ  ¢ƘŜǎŜ 
boxes will be check automatically if you use these actual keys when assigning a key combination. 
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¶ When done, click OK 
 
Note on Assigning Keys and Key Combination:  If you are running a program running via Citrix, 
you might find some keys and key combinations created through OUC will not transmit to the 
application on the Citrix server.  In such a situation you may want to experiment with other 
methods of doing so.  We have found, for instance, the F2 or shift + F2 combination to move 
ǘƘǊƻǳƎƘ άǿƛƭŘŎŀǊŘέ ƴŀǾƛƎŀǘƛƻƴ Ǉƻƛƴǘǎ ƛƴ 9ǇƛŎ ǿƻƴΩǘ ǿƻǊƪ ǿƛǘƘ YŜȅōƻŀǊŘ ŜƳǳƭŀǘƛƻƴΦ  wŀǘƘŜǊΣ ǿŜ 
create a step-by-step command in Dragon and then initiate this command with OUC.  It works 
perfectly. 
 

Launch:  The Launch functionality is highly useful and allows you to assign a button push or pedal 
depression to opening a program or even a specific document.  Setting up such behavior is fairly 
ǎǘǊŀƛƎƘǘŦƻǊǿŀǊŘ ƻƴŎŜ ȅƻǳ ŎƘƻƻǎŜ ǘƘŜ άwǳƴέ tab under USB Device Settings.  You are given the choice of 
opening a program or opening a specific document.  See overview below: 

 

 
 

¶ Open Application:  If you want to program a button to open a program, select the radio button 
ƴŜȄǘ ǘƻ ά!ǇǇƭƛŎŀǘƛƻƴέ ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ǘƻ ǘƘŜ ά9ȄǇƭƻǊŜέ ōǳǘǘƻƴ ǘƻ ƴŀǾƛƎŀǘŜ ǘƻ ǘƘŜ ǎǇŜŎƛŦƛŎ 
executable file (usually found in C:\Program Files(86)\ or C:\Program Files.   Optionally, if you 
understand command line arguments and want to add an argument to your open application 
request, ŀŘŘ ǘƘƛǎ ǘƻ ǘƘŜ ά!ǊƎǳƳŜƴǘǎέ ǘŜȄǘ ŜƴǘǊȅ ōƻȄΦ 

¶ Open Document:  If you want to open a specific document ƻǊ ŦƛƭŜΣ ǎŜƭŜŎǘ ǘƘŜ ά5ƻŎǳƳŜƴǘ ƻǊ ŦƛƭŜ 
Χέ ǊŀŘƛƻ ōǳǘǘƻƴ ŀƴŘ ǘƘŜƴ ŎƭƛŎƪ ƻƴ ǘƘŜ ά9ȄǇƭƻǊŜέ ōǳǘǘƻƴ ǘƻ ƴŀǾƛƎŀǘŜ ǘƻ ǘƘŜ ǎǇŜŎƛŦƛŎ ŘƻŎǳƳŜƴǘ ƻǊ 
file. 

¶ Open Folder:  Program the opening of a specific folder using the same general method used for 
ŀǇǇƭƛŎŀǘƛƻƴǎ ŀƴŘ ŘƻŎǳƳŜƴǘǎ ōȅ ǎŜƭŜŎǘƛƴƎ ǘƘŜ άCƻƭŘŜǊέ ǊŀŘƛƻ ōǳǘǘƻƴ ŀƴŘ ƴŀǾƛƎŀǘƛƴƎ ǘƻ ǘƘŜ ŦƻƭŘŜǊ 
of interest. 

¶ Open Web Page:  although there is not a radio button for this functionality, you can program 
the opening of a specific webpage by simply pasting the URL into the text box to the left of the 
ά9ȄǇƭƻǊŜέ ōǳǘǘƻƴΦ 
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With any ƻŦ ǘƘŜ ŀōƻǾŜ ƳŜǘƘƻŘǎΣ ȅƻǳ Ŏŀƴ ǎŜƭŜŎǘ ŀƴ ά9ȄŜŎǳǘƛƻƴ aƻŘŜέ ŦǊƻƳ ǘƘŜ ŘǊƻǇŘƻǿƴ ŀƴŘ ƘŀǾŜ ǘƘŜ 
choice of Normal, Hidden, Minimized and Maximized. 
 
Note on the Run functionality:  as with the insertion of a web page, if you know the exact location of the 
application, document, or folder, you can enter this directly into window to the left of the Explore 
button. 
 

Windows:  OUC offers the ability to assign to a key or button push any of a series of Windows 
operating system functions, including: 

 
¶ Switch Window (next) 

¶ Switch Window (previous) 

¶ Open Control Panel 

¶ Open Task Manager 

¶ Open Calculator 

¶ Open Power Options 

¶ Open Windows Explorer 

¶ Open Devices and Printers 

¶ Maximize Window 

¶ Restore Window 

¶ Clear Desktop

Hint:  if there are other Window functions you want to assign to a button, there are a series of 
άƪŜȅōƻŀǊŘ ǎƘƻǊǘŎǳǘǎέ ōǳƛƭǘ ƛƴǘƻ ŜǾŜǊȅ ²ƛƴŘƻǿǎ operating system to allow this.  You can use the 
άYŜȅōƻŀǊŘ 9Ƴǳƭŀǘƛƻƴέ ŦǳƴŎǘƛƻƴ ƻŦ h¦/ ǘƻ ŎǊŜŀǘŜ ǎǳŎƘ ōehavior by programming the key combination.  
Please refer to the references in the appendix of this guide for more information on Windows shortcuts.   

 
Custom Script:  This is useful if you desire to set in motion a series of steps with a single button push 
or pedal depression.  The possibilities are endless and each individual step can include any of the actions 
programmable with OUC.  It is possible, for instance, for a single button push to open Microsoft Word, 
insert specific boilerplate text, to open the print menu and to press enter key and then to close the 
document. 

¶ Creating a custom script is as ǎƛƳǇƭŜ ŀǎ ƻǇŜƴƛƴƎ ǘƘŜ ŎǳǎǘƻƳ ǎŎǊƛǇǘ ǘŀōΣ ŎƭƛŎƪƛƴƎ ά!ŘŘέ ǘƻ ŎǊŜŀǘŜ 
your first step, adding steps sequentially, reordering them as needed using the up and down 
arrows, and then clicking OK.  See example of the script described above in the figure below: 
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¶ A few caveats on creating scripts: 
o Sometimes it is necessary to add a slight delay after one entered step to allow it to 

complete before firing the next step.  Opening a program, for instance, might require a 
ǎŜŎƻƴŘ ƻǊ ǘǿƻΦ  Lƴ ǎǳŎƘ ŎŀǎŜǎ ȅƻǳ ǎƘƻǳƭŘ ŜƴǘŜǊ ŀ ǎƘƻǊǘ ά²ŀƛǘέ ŎƻƳƳŀƴŘ ǘƻ ŜŦŦŜŎǘ ŀ 
slight pause as the script is running. 

o Once a script is designed, you can alter the order of the steps within the script by 
selecting a specific step and then pressing the up or down arrow key to alter the 
position of the step. 
 

Advanced:  tƘŜ άŀŘǾŀƴŎŜŘέ ǘŀō provides you the ability to assign separate programming to the 
depression and release of any button, key or lever.   Adding this type of behavior to a button, key or 
lever press is similar to all other OUC programming.  The appearance of the Advanced tab is shown 
below. 
 

 
 
Programming of separate press and release behavior is particularly useful if you want something to 
happen only transiently (while pushing a button for instance) and then ended when the button is 
released.  This type of behavior is especially suited to Dragon users who wish to temporarily put Dragon 
ƛƴǘƻ ŎŜǊǘŀƛƴ άƳƻŘŜǎέ ǎǳŎƘ ŀǎΥ 
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¶ Numbers mode 

¶ Spelling Mode 

¶ Caps mode 

¶ All Caps mode 

 
Please refer to the example shown below for a more detailed look at programming transient Dragon 
modes to a TableMike button. 

 
This type of programming is not limited to use with Dragon.  In fact, you can assign ANY function 
programmable with OUC separately to a button press or release. You could, for instance, assign a press 
of a button to open a program or document and the release to close it, if you wanted to simply gaze at 
the document briefly for a reference. 

 
Example:  LŦ ȅƻǳ ǿŀƴǘ ǘƻ ŀǎǎƛƎƴ ŀ ōǳǘǘƻƴ ƻƴ ȅƻǳǊ {ǇŜŜŎƘ²ŀǊŜ ¢ŀōƭŜaƛƪŜ ǘƻ Ǉǳǘ 5ǊŀƎƻƴ ƛƴ ǘƘŜ άbǳƳōŜǊǎ 
aƻŘŜέ ƻƴƭȅ ǿƘŜƴ ǘƘŜ ōǳǘǘƻƴ ƛǎ ŘŜǇǊŜǎǎŜŘΣ ȅƻǳ ǿƻǳƭŘ Ŧƻƭƭƻǿ these steps: 
 

1.  From the main OUC window select your TableMike from the drop-down menu of connected 
HID devices 

2. {ƛƴŎŜ ƛǘ ǿƛƭƭ ōŜ ŀ άƭƻƴƎέ ǇǳǎƘ ǘƘŀǘ ǿƛƭƭ ƛƴƛǘƛŀǘŜ ǘƘŜ ƴǳƳōŜǊǎ ƳƻŘŜΣ ŘƻǳōƭŜ-click on the line 
ƭŀōŜƭŜŘ ά±ƻƭǳƳŜ 5ƻǿƴ [ƻƴƎ tǊŜǎǎέ  όƛŦ ȅƻǳ ǇǊŜŦŜǊ ǘƻ ŀǎǎƛƎƴ ǘƘƛǎ ŦǳƴŎǘƛƻƴŀƭƛǘȅ ǘƻ ǘƘŜ ǾƻƭǳƳŜ ǳǇ 
ōǳǘǘƻƴ ǘƘŜƴ ŘƻǳōƭŜ ŎƭƛŎƪ ƻƴ ǘƘŜ ά±ƻƭǳƳŜ ¦Ǉ [ƻƴƎ tǊŜǎǎέ ƭƛƴŜύ 
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3. /ƭƛŎƪ ƻƴ ǘƘŜ ά!ŘǾŀƴŎŜŘέ ǘŀō 
4. /ƭƛŎƪ ƻƴ ǘƘŜ άtǊŜǎǎ 9ǾŜƴǘέ ōǳǘǘƻƴ ǘƻ ŀǎǎƛƎƴ ŀ ŦǳƴŎǘƛƻƴ ǘƻ ǘƘŜ ōǳǘǘƻƴ ǇǊŜǎǎ 
5. /ƭƛŎƪ ƻƴ ǘƘŜ ά5ǊŀƎƻƴ /ƻƳƳŀƴŘǎέ ǘŀō 
6. {ŜƭŜŎǘ άbǳƳōŜǊ aƻŘŜ hƴέ ŦǊƻƳ ǘƘŜ ŘǊƻǇ-down menu 
7. Click OK 
8. Repeat steps 4-т ōǳǘ ǳǎŜ ǘƘŜ άwŜƭŜŀǎŜ 9ǾŜƴǘέ ōǳǘǘƻƴ and ǇǊƻƎǊŀƳ ƛǘ ŦƻǊ άbǳƳōŜǊǎ aƻŘŜ hŦŦέ 
9. ²ƘŜƴ ŘƻƴŜΣ ŎƭƛŎƪ άhYέ ǘƻ ŜȄƛǘ ǘƘŜ ǇǊƻƎǊŀƳƳƛƴƎ ƳƻŘŜ ŀƴŘ ǘƻ ǊŜǘǳǊƴ ǘƻ ǘƘŜ Ƴŀƛƴ h¦/ ǿƛƴŘƻǿ 

 
When the above steps are completed your advanced tab settings should appear as shown in the image 
above and the SpeechWare TableMike configuration appears as shown in the graphic at the top of this 
section. 

 
Notes:   
 

1. TƘŜ ά5ƻǳōƭŜ tǊŜǎǎ ŜǾŜƴǘέ ŀƴŘ ά[ƻƴƎ tǊŜǎǎ ŜǾŜƴǘέ ǎƘƻǿƴ ƻƴ ǘƘŜ ŀŘǾŀƴŎŜŘ ǘŀōǎ ŀǊŜ ŦƻǊ ǇƭŀƴƴŜŘ 
future functionality and are not currently available. 

2. When programming a TableMike you will notice that three choices are available for the volume 
down and volume up buttons:  1) Single Press 2) Double Press and 3) Long Press.  If you plan to 
assign an advanced function to one of these buttons you should always assign this programming 
ǘƻ ǘƘŜ ά[ƻƴƎ tǊŜǎǎέ ŦǳƴŎǘƛƻƴ ƻŦ ǘƘŜ ōǳǘǘƻƴΦ  tǊƻƎǊŀƳƳƛƴƎ ǿƘƛŎƘ ŘƻŜǎ ƴƻǘ ƛƴǾƻƭǾŜ ŀŘǾŀƴŎŜŘ 
(separate press and release functions) can be assigned to any of the three button behaviors.  
The beauty of the 3 programming modes for each of the two buttons is that you can assign a 
total of 6 functions to the TableMike buttons, thus offering an abundance of programming 
options to the TableMike. 

 

Altering  Octopus USB Controller Desktop Appearanc e and 
Start -up 
 
.ȅ ǎŜƭŜŎǘƛƴƎ ƻƴŜ ƻǊ ƳƻǊŜ ƻǇǘƛƻƴǎ ŦǊƻƳ ǘƘŜ h¦/ ά±ƛŜǿέ ƳŜƴǳΣ ȅƻǳ Ŏŀƴ ŀƭǘŜǊ ǘƘŜ ŀǇǇŜŀǊŀƴŎŜ ŀƴŘ 
behavior of the application on your desktop. 
 

¶ Start-up:  On initial installation, an icon to start OUC will be placed both on your desktop and 
Start menu.  In this scenario you must start each session of OUC by selecting it from one of 
these locations.  If you prefer to have OUC start automatically each time you boot-up your 
computer, this can be accomplished by navigating to Tools > Options and placing a check-box 
ƴŜȄǘ ǘƻ άwǳƴ ƻƴ ²ƛƴŘƻǿǎ ǎǘŀǊǘǳǇέ 
 

 
 
 

¶ View:  You can also alter the behavior and placement of the main UOC controller window from 
the view menu.  Options include: 

o Floating Bar:  This will show OUC as a full-sized window on your desktop 
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o Tray Icon Only:  This places an icon for OUC in the Windows Taskbar.  While in this mode 
you can right click on the icon to access the Profile, View and Help menus 

o Always on Top:  If you choose this mode, the OUC window will remain on top of all other 
active windows.  Most users will probably NOT want to select this mode since it takes up 
space on your desktop. 
 

 
 

Exporting and Importing User Device Configurati on Profiles  
 
In many ways, the details of the programming you have set up for your devices with Octopus USB 
Controller become a valuable asset.  Consequently, you may want to archive your current device 
configuration profiles for reference, or transfer (import/export) for back-up, transfer to another PC or 
sharing with a colleague.  For an institution or group of users, the ability to set up a new OUC user with a 
complete set of customized device profiles can be huge time saver.  To facilitate these functions, OUC 
includes the ability to perform the following: 
 

¶ Export all device settings 

¶ Import all Device settings 

¶ Print all device setting 

 
!ƭƭ ƻŦ ǘƘŜǎŜ ŦǳƴŎǘƛƻƴǎ ŀǊŜ ŀŎŎŜǎǎŜŘ ǘƘǊƻǳƎƘ ǘƘŜ h¦/ άCƛƭŜέ ƳŜƴǳ ŀǎ ǎƘƻǿƴ ōŜƭƻǿΥ 
 

 
 

Dragon Template/Field Navigation Functionality  
 
The ability to navigate through a document by voice and the creation of ά5ǊŀƎƻƴ ǘŜƳǇƭŀǘŜǎέ ƻǊ άǾŀǊƛŀōƭŜ 
ŦƛŜƭŘǎέ ƛǎ ŀ highly useful functionality seen in Dragon Professional, Legal and Medical.  This functionality 
works by navigating to the next instance of a pair of field delimiters which, by default are a left and right 
squared bracket όάώά ŀƴŘ άϐέύ.  Navigation through a series of Dragon templates can be done in a forward 
ƻǊ ōŀŎƪǿŀǊŘǎ ƳŀƴƴŜǊ ŀƴŘ ŀǊŜ ŀŎŎƻƳǇƭƛǎƘŜŘ ōȅ ǎŀȅƛƴƎ άƴŜȄǘ ŦƛŜƭŘέ ƻǊ άǇǊŜǾƛƻǳǎ ŦƛŜƭŘέ ŀƴŘ ǘƘƛǎ ŎƻƳƳŀƴŘ 
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Ŏŀƴ ŀƭǎƻ ōŜ ƛƴƛǘƛŀǘŜŘ ōȅ ŀ ōǳǘǘƻƴ ǇǳǎƘ ōȅ ŀǎǎƛƎƴƳŜƴǘ ƻŦ ŀ 5ǊŀƎƻƴ άƘƻǘƪŜȅέ ŦǊƻƳ ǘƘŜ ¢ƻƻƭǎ Ҕ hǇǘƛƻƴǎ 
menu.  Use of this functionality is highly useful when creating letters, notes, and other documents that 
share common regions and in which you simply want to navigate to different locations for dictation of 
specific variable text. 
 
Octopus USB controller offers two means of extending the use of Dragon Templates: 
 

1.  h¦/ Ŏŀƴ ōŜ ǳǎŜŘ ǘƻ ǇǊƻƎǊŀƳ ǘƘŜ ŎƻƳƳŀƴŘ άƴŜȄǘ ŦƛŜƭŘέ ƻǊ άǇǊŜǾƛƻǳǎ ŦƛŜƭŘέ ǘƻ ŀƴȅ ōǳǘǘƻƴΣ ƪŜȅ ƻǊ 
ƭŜǾŜǊ ōȅ ŎƘƻƻǎƛƴƎ ǘƘƛǎ ŦǊƻƳ ǘƘŜ ά5ǊŀƎƻƴ /ƻƳƳŀƴŘǎέ ǘŀō ƻƴ h¦/Φ  Lǘ ǎƘƻǳƭŘ ōŜ ƴƻǘŜŘ ǘƘŀǘ ǘƘƛǎ 
native function is operational only in Dragon Professional, Legal and Medical versions. 

2. OUC extends ǘƘŜ ǳǎŜ ƻŦ άƴŜȄǘ ŦƛŜƭŘέ ŀƴŘ άprevious fielŘέ ŎƻƳƳŀƴŘǎ ǘƻ ǘƘŜ Premium version of 
Dragon when used in Microsoft Word. 
 

Utilizing the Dragon Microphone Indicator Functionality  
As an added feature for Dragon NaturallySpeaking users, SpeechWare has added functionality to 
Octopus USB Controller to assist in microphone management.  This feature provides you with the option 
of placing a άmicrophone status indicatorέ on the desktop to provide a more obvious indicator of the 
microphone on/off/standby status.  It can be configured to vary its size and can be moved anywhere on 
the desktop.  See figures below to see the appearance of the indicators and the Options menu used to 
program the size of the indicator.  Moving the indicator involves dragging it across the desktop. 
 
Appearance of Microphone Status Indicator buttons: 
 

   
Size Options for Microphone Status Indicators:  Sizes between 1 and 10 can be chosen and 
representative sizes are shown below: 

 
Size 1 Size 5 Size 10 

 

 

 
Microphone Status behavior is controlled from the Options menu depicted below: 
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Appendix  
 

Compatible Devices:  The following USB foot pedals, hand-held microphones and other devices are 
know to be compatible with the Octopus USB Controller and will provide device specific information 
when programming: 
 

USB Foot Pedals 

¶ Buddy/Insync FootSwitch 7G 

¶ Buddy/Insync ElbowSwitch 7G 

¶ Certified Transcription Aid Pedal 

¶ Grundig Digta Foot Control 538 USB  

¶ Grundig Digta Foot Control 540 USB  

¶ Grundig SoundBox 830 USB  

¶ Infinity IN-USB1* 

¶ Infinity Foot Control IN-USB-2  

¶ Infinity Foot Control IN-SRW  

¶ Olympus Foot Switch RS27  

¶ Olympus Foot Switch RS28  

¶ Olympus Foot Switch RS31  

¶ Philips Foot Control LFH 2320  

¶ Philips Foot Control LFH 2330  

¶ SpeechWare USB Single Foot Pedal 
(under development) 

¶ SpeechWare USB Triple Foot Pedal 
(under development) 

¶ Xkeys USB 
 

Hand-held USB Microphones: 

 

¶ Buddy StylusMic 

¶ Nuance/Dictaphone PowerMic II 

¶ Olympus DR-1200 

¶ Philips Speechmike Air LFH3000 

¶ Philips Speechmike Classic 6264  

¶ Philips Speechmike Pro 5276  

¶ Philips Speechmike LFH3500/00  

¶ Philips Speechmike Classic 6264  

¶ Philips SpeechMike 6274 

¶ Philips Speechmike Pro 5276  

 
Desktop USB Microphones (Volume 

Up/Down buttons): 

¶  

¶ SpeechWare USB 3-in-1 TableMike 

¶ SpeechWare USB 6-in-1 TableMike 

¶ SpeechWare USB 9-in-1 TableMike 
 

USB KeyPads:  All tested keypads have been 
found to be compatible with OUC. Specific 
button functionality is not seen until a 
button is programmed. 
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*Recognized as an Infinity IN USB2 but 
programs normally. 

 

 

Non-Compatible Devices: 

 
Octopus USB Controller has been programmed to be compatible with virtually every commonly used 
USB hand-held microphone and foot pedal.  If you have a device which is not compatible, it can still be 
ǳǎŜŘ ŜƳǇƭƻȅƛƴƎ ǘƘŜ ά!ǳǘƻ[ŜŀǊƴέ ƳŜǘƘƻŘƻƭƻƎȅ ŘŜǎŎǊƛōŜŘ ŀōƻǾŜΦ  {ǇŜŜŎƘ²ŀǊŜ ƛǎ ƛƴǘŜǊŜsted in adding 
ƴŜǿ ŘŜǾƛŎŜǎ ǘƻ h¦/ ǳǇƎǊŀŘŜǎΣ ǎƻ ǇƭŜŀǎŜ ŜƳǇƭƻȅ ǘƘŜ άwŜǇƻǊǘ ƛƴŎƻƳǇŀǘƛōƛƭƛǘȅ ƻǊ ǇǊƻōƭŜƳΦΦέ ŦǊƻƳ ǘƘŜ 
tools menu to report an incompatible device. 

Windows Shortcuts: 
 

Additional behavior can be assigned to a button by using the Keyboard Emulation tab and use of 
ǎǘŀƴŘŀǊŘ ά²ƛƴŘƻǿǎ {ƘƻǊǘŎǳǘǎέ ǿƘƛŎƘ ŀǊŜ ƪŜȅōƻŀǊŘ ǎƘƻǊǘŎǳǘǎ ōǳƛƭǘ ƛƴǘƻ ²ƛƴŘƻǿǎ ƻǇŜǊŀǘƛƴƎ ǎȅǎǘŜƳǎ ǘƻ 
allow simplified access to commonly employed functions.  Information on shortcuts can by found by 
ǎŜŀǊŎƘƛƴƎ ά²ƛƴŘƻǿǎ ƪŜȅōƻŀǊŘ ǎƘƻǊǘŎǳǘǎέ ƻǊ Ǿƛsiting an extensive table of shortcuts on Wikipedia at:  
http://en.wikipedia.org/wiki/Table_of_keyboard_shortcuts  
 

Working with Microsoft Excel:  

 
As with Windows in general, there are many shortcuts which allow navigation and functioning within an 
Excel spreadsheet with hotkeys. This becomes an easy process to emulate with a button, key or lever 
push using OUC.  For a list of common shortcuts, we recommend you visit any of the links below: 
 

¶ http://office.microsoft.com/en-us/excel-help/excel-shortcut-and-function-keys-
HP010073848.aspx 

¶ http://www.stanford.edu/dept/EHS/prod/general/ergo/documents/Excel_Specific_keyboard_s
hortcuts.pdf  

 
For example, one might need to repeatedly open a specific Excel document and navigate to a 
ǎǇŜŎƛŦƛŎ ŎŜƭƭ ǿƛǘƘƛƴ ǘƘŜ ŘƻŎǳƳŜƴǘΦ  ¢Ƙƛǎ Ŏŀƴ ōŜ ŀŎŎƻƳǇƭƛǎƘŜŘ ǳǎƛƴƎ ŀ ά{ŎǊƛǇǘέ ƛƴ ǿƘƛŎƘ ǘƘŜ 
following actions take place: 
 

1. Run command opening the document you desire 
2. hǇǘƛƻƴŀƭ ǎƘƻǊǘ ά²ŀƛǘέ 
3. YŜȅ ŜƳǳƭŀǘƛƻƴ ƻŦ Cр όƻǇŜƴǎ ǘƘŜ 9ȄŎŜƭ άDƻ ¢ƻέ ŘƛŀƭƻƎ ōƻȄύ 
4. Boilerplate text to enter the  cell location (column followed by row, i.e. A5, F33, etc.) 
5. YŜȅ ŜƳǳƭŀǘƛƻƴ ƻŦ ŀ άwŜǘǳǊƴέ ƻǊ ά9ƴǘŜǊέ ƪŜȅ 

 

Location of Common Programs/Executable Files 

 

http://en.wikipedia.org/wiki/Table_of_keyboard_shortcuts
http://office.microsoft.com/en-us/excel-help/excel-shortcut-and-function-keys-HP010073848.aspx
http://office.microsoft.com/en-us/excel-help/excel-shortcut-and-function-keys-HP010073848.aspx
http://www.stanford.edu/dept/EHS/prod/general/ergo/documents/Excel_Specific_keyboard_shortcuts.pdf
http://www.stanford.edu/dept/EHS/prod/general/ergo/documents/Excel_Specific_keyboard_shortcuts.pdf
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If you are seeking to initiate the opening of a specific program with functionality facilitated by the Run 
tab, you will need to navigate to the executable file for the application.  Most of these are contained in 
the C:\Program Files (x86)\ ŦƻƭŘŜǊ ǿƘƛŎƘ ƛǎ ǎƘƻǿƴ ōȅ ŘŜŦŀǳƭǘ ǿƘŜƴ ȅƻǳ άŜȄǇƭƻǊŜέ ŦƻǊ ŀ ǇǊƻƎǊŀƳ ŦƻǊ h¦/Φ  
Not so obvious is where some programs are located within this folder.  Here are locations for some 
common applications: 
 

Google Chrome:  C:\Program Files (x86)\Google\Chrome\Application\chrome.exe 
Internet Explorer:  C:\Program Files\Internet Explorer\iexplore.exe 
Microsoft Excel 2007:  C:\Program Files (x86)\Microsoft Office\Office12\EXCEL.EXE 
Microsoft PowerPoint 2007:  C:\Program Files (x86)\Microsoft Office\Office12\POWERPNT.EXE 
Microsoft Word 2007:  C:\Program Files (x86)\Microsoft Office\Office12\WINWORD.EXE 
NaturallySpeaking 12:  C:\Program Files 
(x86)\Nuance\NaturallySpeaking12\Program\natspeak.exe 
WordPad:  C:\Program Files (x86)\Windows NT\Accessories\wordpad.exe 

 
! ǎƛƳǇƭŜ ǿŀȅ ǘƻ ŦƛƴŘ ǘƘŜ ƭƻŎŀǘƛƻƴ ƻŦ ŀ ǇǊƻƎǊŀƳ ƛǎ ǘƻ ŜƴǘŜǊ ǘƘŜ ƴŀƳŜ ƛƴ ǘƘŜ ά{ŜŀǊŎƘ ǇǊƻƎǊŀƳǎ ŀƴŘ ŦƛƭŜέ ƻŦ 
the Start Menu and if you see the program, rather than clicking on it, right click on the program and 
ǎŜƭŜŎǘ άhǇŜƴ CƛƭŜ [ƻŎŀǘƛƻƴέ 

Opening Browser with Pre -specified Search 

 
If you have a reason to open a browser very regularly and with a pre-defined search topic, this can be 
ǇǊƻƎǊŀƳƳŜŘ ƛƴǘƻ ŀ άwǳƴέ ōŜƘŀǾƛƻǊ ŀǎǎƛƎƴŜŘ ǳǎƛƴƎ h¦/Φ   
 
Bing:  www.bing.com/Search?q=term1+term2 
Google:  https://google.com/#q= term1+term2+term3 

 

Sources of Additional Information:  
 

¶ http://www.tablemike.com/en/download-applications.php  

¶ http://OctopusUSBController.com  
 

 Caveats on Using Octopus USB Controller 

 

¶  If your USB device has dedicated controlling software which is also running, you may find 
erratic behavior since button pushes may be initiating action through both OUC and the 
other controlling software.  In such a situation we recommend that you either turn off or 
uninstall the other device controlling software.  If you absolutely need that software, then 
you should be sure to configure the other software not to control any buttons you desire to 
control with OUC. 
 

¶ When using the Octopus USB Controller with the Philips SpeechMike Premium (LFH3500) 
keep in mind that this microphone has an onboard gyroscope/position sensor and may 
provide input which may be recognized by OUC simply by picking it up or laying it down.  As 
of this time we are not aware of a method to disable this functionality, so we recommend 

http://www.tablemike.com/en/download-applications.php
http://octopususbcontroller.com/
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using a key other than the record button to control the microphone on/off function. 
 

¶ The Buddy/Insync StylusMic has two buttons which can be programmed.  The top-most 
button (nearest the microphone) is programmed by default to turn the microphone off and 
on.  If you wish to have the behavior defined by OUC and not the default behavior, we 
ÒÅÃÏÍÍÅÎÄ ÔÈÁÔ ÙÏÕ ÕÓÅ ÔÈÅ )ÎÓÙÎÃ Ȱ-Ù"ÕÄÄÙȱ ÓÏÆÔ×ÁÒÅ ÔÏ ÔÕÒÎ ÏÆÆ ÔÈÅ ÄÅÆÁÕÌÔ ÂÅÈÁÖÉÏÒ ÏÆ 
the device. 
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